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 What is Geographic Information System (GIS)?

• The study of people, places, things and their relationship to one another
• A computer based system to capture, store, edit, manipulate and display

graphically referenced information
• GIS is about data:

- Locating it
- Maintaining it
- Relating it to other data
- Displaying it
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• Leading GIS Companies:

- MapInfo Corp.
- Intergraph Corp.
- PlanGraphics, Inc.
- Environmental Systems Research Institute (ESRI), Inc.

• ESRI
- ArcInfo®
- ArcView®
- PC ArcInfo
- ArcCad
- Et al

• ArcView®:
- Desktop GIS
- Easy to use graphical user interface (GUI)
- Tools for creating, editing, querying, analyzing, and viewing data
- Software comes with large amounts of data
- Operates on Windows, Macintosh, and Unix platforms
- Customizable with Avenue
- Extensions to digitize, project, use CAD images, et al

• How ArcView® works:
- Features on a map are linked to a table of attributes (database)
- Each feature has a unique record
- A set of features and attributes are called themes
- Themes can be queried, analyzed, mapped, and printed.

Urban Boundary Theme:
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ArcView® Interface

• When you open ArcView®, you will see the ArcView® Application window.
• The Application window contains a basic Microsoft® Windows® type of menu and an

ArcView® Project window.
• A Project window contains the names of various types of Documents.
• The image above, called a Project, has no documents listed because it is the default

project, which is empty.
• As you add views, tables, charts, etc., you will give your project a unique file name so that

you can be saved and called up again.
• A Project file is in ASCII format that can be view with any word processor.
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ArcView® Documents:

• There are five basic types of Documents:
Views:    Displays maps or images of spatial data
Tables:   Contains the attribute tables of views.  May contain stand alone
                 database tables.
Charts:   Lists charts created from any database table in the project.
Layouts:  Display images of views, charts, and tables that are to be printed.
Scripts:   Scripts are programs written in Avenue® to create custom applications
                 or functions.

• Only one Document can be active at a time.  The title bar of an active Document will
appear raised and darkened.

• Each Document will have its own Graphical User Interface (GUI) with unique menu,
button, and tool bars.

• Putting the cursor on an icon will provide a brief description of the icon’s function.

• A detailed description of any icon can be displayed by selecting the Help icon  and
selecting the desired icon.

Table

LayoutView

Chart
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View Document:

•    Contains maps and other images.
•    Has a unique GUI.
•    Can be moved or resized.
•    Can contain one or more themes.
• One, many, or no themes can be active at one time.
• Themes will draw in an order beginning with the bottom theme.
• Themes may be covered up by other themes if they are in the incorrect order.
• Themes may be turned off or on by clicking the checkmark box of the theme.
• In order to select or query features, the respective theme must be active (appears raised).
• Has a status bar at the bottom of the screen that provides information on measurements and

on the status of long processes.

Tool Bar

Display
Scale

XY
Coordinate

View
Document

Project
Document

Button Bar
Menu Bar

Status Bar

Title Bar

Table of
Contents
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Exercise 1: Working with Views and Themes

1. Open ArcView® by clicking the ArcView® icon or by clicking Start, point to Programs.
Find the ESRI menu and click on ArcView® GIS Version 3.1.

2. From the file menu, select Open Project.

3. A dialog box will appear showing a sub-directory on the right and a list of project files, if
any, on the left.

4. Move to the sub-directory called c:\av_class\lessons.

5. From the list of projects, select excer1.apr.

6.   Resize and move the Application and View windows.

7. Make the View active; then make the Project window active. Compare GUIs.

8. Click on the Help button  and click several other buttons to see their function

9. Turn any theme off and back on again by clicking the Check Box .

10. Change the order of themes by dragging the themes up and down.  Notice the effect.

11. Zoom in and out of the view using the Button bar icons .  Use
the Help button to see the zoom buttons’ descriptions. Zoom in and out of the view using

the Tool bar icons . What is the difference between using the Button bar and the

Tool bar? Pan by using the Pan button .

12. While the cursor is in the View window, hold down the right mouse button.  What’s
available?

13. Using the Query button  to query features of the various themes.  Remember that the
appropriate theme must be active.

14.  Make the Project window active.  Under the File menu, Close the file. Do not save the
project.
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Table Document:

• Contains the Attributes of a theme or other database table.  A Table is not necessarily
attached to a theme.  It can be a stand-alone database such as a lookup table.

• Attribute tables are in a dbf format and can be edited with common software programs
such as FoxPro, dBase and Excel.

• Opened by clicking the Open Theme Table icon  while in a View or by going to the
Theme Pull-down menu and selecting Table.

• Each feature in a theme will have a Record and one or more Fields.

• You can select specific features by using the Select Feature tool  that allows you to

select features graphically.  The query builder  allows you to select features by
building tabular expressions.  Selected records or features will be yellow in color.  Records
can be added to the selected set by holding down the shift key.

• The Promote button  moves selected records to the top of the file to be easily viewed.

• ArcView® allows you to sort records by using the sort tools .
• Selected records can be used to create a new theme by going to the Theme pull down menu

and clicking on Convert to Shape File.
• Attribute tables can be joined or linked to other tables based on a common Field.

Field

Record
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Building Tabular Queries:

• Tabular Queries are created by selecting records from data in the Attribute Table.

• The Query window can be displayed by clicking the Query Builder button  or by
going to the Theme pull-down menu and selecting Query.

• Expressions can be created by combining fields with mathematical operations and field
values. Specific values may by typed in.

• Complex queries can be created by combing expressions.  ArcView®’s query builder can
be complicated when building complex expressions.  Look under Query Builder (Dialog
Box) in the Help menu for guidelines in building queries.

• Subsets of selected sets of data can be created by using the optional boxes in the Query
window.

• Selected records can be saved to create a new Shape file or can be exported to a database
or text file.
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Exercise 2: ArcView® Tables

1. From the file pull-down menu, select Open Project.

2. If necessary, move to the sub-directory called c:\av_class\lessons.

3. From the list of projects, reselect exercise excer1.apr.

4. Make the View active and make the aztowns.shp theme active.

5. Click on the Open Theme Table icon 

6. Scroll through the list of field names and records.

7. Select the name field then sort it using the Sort buttons .  Select the population
field and sort the records in the two methods.

8. Select records from the attribute table by clicking any record.  Hold down the shift key to
select more than one record.  Notice that as you highlight a record, the related feature in
the View Window also turns yellow in color.  Move or resize the attribute table if
necessary to see the features in the View.

9. With records still selected, go to the button bar and experiment with the Selection icons

. Use the Help button  to see their function.

10.  Select all records using the appropriate icon.  Make the population field active.  Click on
the Field pull-down menu and select the Statistics option. Notice the various statistical
values. Note the total population.

11. Unselect all records and close the attribute table.  Make the View and the Aztowns.shp
shape file active.

12. Using the Select button , select several records from the Aztowns theme.  Hold down
and drag the left mouse button, creating a box, to select several records.  Hold down the
shift key to pick additional towns.  Bring up the file attribute table and prompt the selected

file to the top using the Prompt button .  Unselect all records.

13. Click on the Query builder button .  Select records that have a population greater than
5,000.  Open the attribute table and prompt the selected records to the top.

14. Select the population field.  Click on the Field pull-down menu and select the Statistics
option. Compare the total population with the total population found in step 10.

15. Make the View active. Go to the Theme pull-down menu and select Convert to Shape File.
Save the selected records to c:\av_class\lessons\Major.shp. If a “major.shp” shape file
already exists, overwrite it or give it a different name.  Click on Yes to add the major.shp
theme to the view.  Turn off the aztowns theme and turn on the major theme.



10

Building Spatial Queries:

• Spatial Queries are created by selecting features based on their relationship to other
themes or features.

• A selector theme must first be picked.  This can be the same theme that you are selecting
from or a separate theme.

• In the above example one county was selected from the active them.  The theme containing
the desired features must then be made active.

• The Select By Theme menu item is selected from the Theme pull down menu
• Various types of selection options exist:
                Are Completely Within
               Completely Contain
               Have their Center In
               Contain the Center Of
               Intersect
              Are Within Distance Of
• Selected records can be saved to create a new Shape file or can be exported to a database

or text file.
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Exercise 2a: Spatial Queries

1.   From the file pull-down menu, select Open Project.

2. If necessary, move to the sub-directory called c:\av_class\lessons.

3. From the list of projects, reselect exercise excer1.apr.

4. Make the View active and make the Cntybdys.shp theme active.

5. Select any county or a number of counties using the selection tool  or by using the

tabular query tool .

6. Make the aztowns.shp theme active.

7. Go to the Theme pull down menu, and select the click the Select By Theme option.

8. Go to the lower drop down list of the dialog box  (selected features of) and select the
Cntybdys.shp theme.

9. Move up to the upper drop down list (Select features of active theme that) and select  That
Are Completely  Within.

10. Click the New Set button.

11.  Clear the selected set from the counties theme by making the Cntybdys.shp active again,

and clicking on the Clear Selected Features button .

12. Make the aztowns.shp theme active.  Go to the Theme pull down menu. Click Convert to
Shape File.  Convert the selected features to a new theme in the c:\av_class\data
subdirectory using an appropriate name, i.e. coch_twns.shp.

13.  Add the theme to your view if you wish.

14. Try selecting another set of towns using another method.
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Getting help.

• ArcView® has a very robust Help system.

• Already mentioned, the Help button  that gives information about any of ArcView®’s
buttons, tools, or menu choices.

• The Help pull-down menu provides three types of help.
• Contents gives introductions, overviews and descriptions of most ArcView® topics.

Contents are organized as books that, when opened, expand the contents of the book.
•  Index allows you to type in a key word or a topic.  ArcView® then displays a list of

entries for that word.
• The Find tab allows you to search for specific words in combination with other words and

phrases.
• The Help system uses a hypertext system that allows you to jump to a highlighted word

that contains additional information on a topic.
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Document & Theme Properties

View Properties:

• The appearance and function of documents and themes are controlled by setting and
controlling their Properties.

• Opening View Properties allows you to change basic information such as the View Name,
Date, Creator, Background Color, etc.

• The most import function of View Properties is to define Map Units and Distance Units.
These definitions are necessary if you need to make distance measurements or make a
scale bar in a layout.

• In order to understand how Map Units and Distance Units change, you need to have a
basic understand of Map Projections.
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Map Projections:  The world flat! (When projected):

• The earth is a spheroid, a three dimensional object.
• All flat maps, two-dimensional objects, are projected in some way.
• Projecting a map always cause some type of distortion – angles, shape, area, or distance.
• There are many types of projections, but there are three basic types (dependent on

locations of latitude):
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• You need to know what projection your map is in when you exchange files with other
organizations.  If you do not know:
- Ask whoever is providing you with the map.
- If provided, Metadata may have a projection file information.
- If you have ArcInfo, the describe command will give projection information on the

cover
• ADOT uses a projection called State Plane Central, NAD 83, in meters. This projection

is based on the Transverse Mercator projection.
• The State Land Department uses Universal Transverse Mercator (UTM) projection.
• You do not need to set the projection in the View Properties if the Themes in the View are

already projected (not latitude & longitude).
• North American Datum (NAD) describes the size and shape of the earth.  Datums are

part of the parameters when setting projections. There are two types commonly referenced,
NAD 27 and NAD 83.  Changes in datums cause changes in the planer coordinate system
i.e., latitude and longitude). Therefore, locations of features change. NAD 83 is used by
most governmental agencies.  You may need to know this when projecting maps.
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Theme Properties:

• Setting Theme Properties will set how the theme appears as well as how it will respond to
various functions.

• The legend in the view can be made more understandable by changing the Theme Name.   
Changing the theme name does not actually change the shape file name.

• Definitions in the theme allow you to select specific records in the view.
• Setting Text Labels will define which field will be used as the labeling field.
• Geocoding sets up rules for geocoding addresses.
• Setting Editing properties will help in adding and editing records. If you do not see the

Editing icon, you probably do not have write access to the shape file. Using the Windows
file manager can change this.

• The Display setting allows views to be turned off and on depending on map scale.
• Hot Links are set up to connect features such as photographs, scripts, projects, or text

documents.
• Locking write protects theme properties.
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Exercise 3.

1. Open the project Exer2.apr in the c:\av_class\lessons directory.

2. Click on the View pull-down menu and select Properties.

3. Rename the View “USA” or something relating to the image.

4. Set the map units to decimal degrees and the distance units to miles.

5. Click on OK.  Observe the shape of the states.

6. Open View Properties again. Click on the Projection box.

7. Set the Category to UTM 1983 and the Type to Zone 12.

8. Click on OK and observe the shape of the states.

9. Click on the Theme pull-down menu and select Properties.

10. Change name of the theme to “States”.

11. Close the Theme Properties menu by clicking OK.

12. Click on the Identify button  and click on several states.

13. Close the project and do not save.
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Feature Types:

Feature Types:

• Lines(arcs):
- Roads
- Rivers
- Fault lines

• Points
- Towns
- Signs
- Events (accidents, projects, etc.)

• Polygons  (made from lines)
- Political Boundaries
- Land Use
- Riparian Areas
- Events (toxic, spills, noxious weeds, etc.)

• Routes
- Groups of lines (arcs)

• Regions
- Groups of polygons
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Nodes- Ending points of lines

• Nodes are beginning and ending points of lines
• Every line segment (arc) will have a beginning and ending point
• Every arc in the HPMS database will have a street/road name called Onroad
• The beginning point of an HPMS line is called the  Swterm (south/west termini)
• The ending point of an HPMS line is call end  Neterm (north/east termini)
• The HPMS record will also have an offset value call Swo and Neo
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Data Sources:

• ArcInfo® files
- Called coverages or covers which are made up of a sub-directory and an info file
- Usually obtained in an ArcInfo® interchange (E00) format
- ArcView® has an Import utility to bring ArcInfo® files into ArcView®

• CAD Drawings (AutoCAD & MicroStation)

• Text files having a spatial reference such as latitude and longitude.

• Global Positioning System (GPS) files

• MapInfo® (Ugh!) files in a MIF format

• Images (JIF, TIF, etc.) that have been rectified.

• Digitized drawings (from screen or digitizing board)

• ArcView® Shapefiles

ArcView® Shapefiles:

• ArcView®’s file format
• Shapefiles run faster and more efficiently than ArcInfo® coverages
• Shapefiles can be edited with ArcView®
• Shapefiles dbf files can be edited with other programs, i.e. FoxPro, Excel, dBase
• Shapefiles have three parts

- .shp - contains the geometry
- .shx – stores the index of the geometry
- .dbf – stores the attributes of each feature in a dBASE format

• Shapefiles may have other files attached when you create and index or do a spatial join
-  .sbn & .sbx
- these files are not necessary when copying them to another location
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Working with Shape Files:

The above view has three types of themes
• ArcInfo cover  (Wildren)

- ArcInfo coverages consists of two sub-directories, the ArcInfo file and an Info file
- ArcView® will run more efficiently if you convert the ArcInfo file to a shape file

• Shape files (Gila_atis.shp, Gila.shp)
• Image file (straw.tif)

Remember:
• Data must be in the same projection.
• Save often.
• Themes must be active in order to perform any function on it.
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Classifying Themes:

Themes can be mapped thematically or classified:
• Single symbol
• Unique value
• Graduated color
• Graduated symbol
• Dot density
• Chart

Legends can be saved for later use (. avl file).
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Classifying population of the Arizona towns theme:

 

Towns classified using graduated color.             Towns classified using graduated symbol.

.

Functional classification classified using        Counties classified by COG unique value.
unique value.
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Exercise 4.

1. Open ArcView.

2. Open a new project.  Create a new view by double clicking the Views  icon in the
Project window or by clicking New at the top of the Project window.

3. Drag and resize the new view so that it does not cover up the Project window.

4. From the button bar, click on the add theme button .   (Make sure that the View project
window is active.)

5. Go to the c:\av_class\data directory and add the county boundary shape file
(cntybdys.shp).

6. Add the city boundary ArcInfo® coverage (c:|av_class\data\cities\cities).   Convert the
cover to an ArcView® shape file and name it cities. When asked to add the theme to the
View, select Yes. Make the ArcInfo® cover active. Go to the Edit pull-down menu and
select Delete Theme.  Click on Yes to delete the theme.

7. With the View document active, double click the counties shape file.

8. Classify the theme using Unique Value on the name Value Field.  Try different color
schemes.  Classify individual counties by double clicking its symbol.  Classify the theme
by COG Value Field.  Finally, set the classification to single symbol with a blank fill (no
color).

9. Add and make the aztowns.shp theme active.  Classify the theme by graduated symbol
using the population field.

10. Add the HPMS 98 shape file (hpms98.shp).

11. Make the hpms98.shp theme active.  Double click the theme to open the Legend Editor.
Click on Load.   Move to the c:\av_class\lessons sub-directory and select funcclass.avl.
Click on All, Okay, and Apply.   Close the Legend Editor.

12. Make the Project window active.  Save the project as HPMS98 and close the project.
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 Creating new data

• Shapefile features and their attributes can be easily modified
• New themes and features can be added.
• Before editing can begin, the view and theme properties should be set.
• Attribute Updating determines how fields will be updated as changes are made to

features
• Setting Snapping will help in creating new arcs and polygons that must connect to other

arcs and polygons.
• Overshoots and Undershoots
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Exercise 5.

1. Close any projects that may be open.

2. From the c:\av_class\lessons sub-directory open the exerc4.apr project file.

3. With the View active, open the View Properties.

4. Make the Map Units equal to meters and the distance units equal to feet.

5. Make the gila_atis.shp theme active.

6. Click on Theme Properties.  On the left side of the window, click on Editing.  Near the
bottom of the box, click on General Snapping and set the Tolerance to 25 feet.  Click on
Okay.

7. Under the Theme Menu, click on Start Editing.  Notice that a dashed line now appears
around the check box for the theme that you are editing.

8. Zoom into the town of Strawberry so that the local streets on the quad map are visible.

9. Make sure the gila_atis.shp is active. Under the Tools button bar, select the Draw Line
tool.   Find a road that you want to add to the gila_atis shape file. Click on a beginning
point (node) near SR 87.  Digitize the road by clicking points along the road.  Double click
the last point to stop editing.

10. After you have finished adding road segments go to the Theme pull-down menu and click

Stop Editing and save the additions.   Use the Select tool   while in the View
Document to select one of the new roads you added.

11. Open the Attribute Table .  Go up to the Table pull-down menu and click Start

Editing. Promote  the selected record to the top. Using the  Tools button, add a
fictitious name data to the Onroad field of the newly added record.  Add names to the
Neterm and Swterm fields using actual termini or enter a fictitious road.

12.  Go to the Table pull down menu and click Stop Editing.  Save the changes.

13. Make the View Document active. Make the Gila_atis.shp them active. Go to the tool bar

and select the Calculate Feature Geometrics button .  This will recalculate the lengths
or areas of theme features.  Remember that map units (meters) must be set for correct
calculations.   Neither the table nor the view needs to be editable.

14.  Open the Attribute table  and look at the new Length field.

15.  Go the File pull down menu and save the project.  Do not close the project.
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Populating Fields With Field Calculator

• Fields can be easily populated with the Field Calculator .
• The table must be editable.
• Numeric, string, and date fields can be populated.
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Exercise 5a.

1. Make sure that the exerc4.apr project file is still open and the View document is active.

2. In the View properties, change the distance units to miles.

3. Open the Attribute file  for the Gila_Atis theme.  The Table Document should now be
active.

4. Go to the Table pull down menu and click Start Editing.

5. Go to the Edit pull down menu and click Add Field. A Field Definition dialog box will
open.

6. Enter “Miles” in the Name: field. Leave Type as a Number field.  Change Width to 10 and
Decimal Places to 2.  Click OK.

7. Make the new field, Miles, active.

8. Click on the Calculator icon .

9. While the cursor is in the lower blank dialog box, go up to the Fields dialog box and
double click on the [length] field.  Go to the Requests dialog box and double click on the
* numeric operator. The cursor will move to the bottom Fields dialog box.  Enter
“(0.0006214)” (miles in a meter) after the * numeric operator. Do not enter quote marks.
This should populate the Miles field. If an unrelated dialog box appears on the screen,
close it.

10.  Click OK.  Stop editing and save.

11. Select a road segment in the View, open the attribute table, and check the Miles field.

12. Use the Distance measuring tool  to check the length against the length in the Miles
field.

13.  Close and save the project.
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Adding labels to a theme:

• Labels on a line theme

• Labels on point theme
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Setting up ArcView® for labeling

• Setting properties for a line theme

• Setting properties for point and polygon themes
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Labeling features:

• Individual features may be labeled using the Label tool .   Label one feature and then
use the Font Palette to adjust the Font type and size.  The Font Palette can be found by
opening the Window pull-down menu and clicking Show Symbol Window and the Font

Button .
• Double clicking the label will open an editing window that will allow you to change the

text and the angle.

Using the Auto-label function:

• The Auto-label function will label all of the features in an active theme.
• Before starting the Auto-label, set the font type and size.  Otherwise, you find your screen

covered by very large text.
• Options must also be set before starting the Auto-label function: Label Field, Placement

Property, Allow Overlapping Labels, Scale Labels, and Label Only Features in View
Extent.
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Exercise 6.

1. Close any projects that may be open.

2. Open a New project and a New view.

3. Click on the Add Theme button . Go to the c:\av_class\data sub-directory.  While
holding the shift key select the cntybdys.shp and aztowns.shp shape files.  Change their
color and shape pattern by using the Legend Editor.

4. Select Properties from the View  pull-down menu. Set the Map Units to meters and the
Distance Units to miles.

5. Make the aztowns.shp shape file active. Open Theme Properties. Change the theme name
to Arizona Towns.  Set the Definition to towns with populations greater than 5,000. Set the
Text Labels option to the town name (name).  Set the Label Position to the upper right
location.

6. Go to the button bar and select the Label icon .  Move to the View Document and label
a town.  Open the Window pull-down menu and select Show Symbol Window to open

the Font Palette .  Select a font size that is more appropriate for the map scale.

7. Select any town labels with the Select tool  , and delete them.

8. Go to the font palette and set the Font size with the appropriate fond size.  Try labeling
some towns again.

9. Select all the town labels again and delete them.  You may go to the Edit pull-down menu
and click Select All Graphics.   Hit the Delete key.  Be careful because this will delete all
labels from any active view.

10. Go to the Theme pull-down menu and select Auto Label. Click on OK.

11. If the font size is too large.  Delete all the labels, and reset the font size from the Show
Symbol Window menu (under the Window pull-down menu). Do the Auto Label function
again.

12.  Zoom in on a couple of towns.  Move the label if it is not in a good place.

13. Zoom to the extents of the themes. Go to the File pull down menu, and click on Save
Project As.   Name the project aztowns.
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Creating layouts.

• With practice, you too can make a map like the one above.
• The map shows good balance in design.
• When designing a map, consider who your audience will be.

Note:  Map courtesy of Cody Garrison, age 7.
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Layout GUI:

• Layouts are maps containing views, charts, tables, and other graphic images.  Layouts can
be printed or plotted to a hard copy.  Layouts may be exported to an electronic file so that
the map can be used in other programs such as a word processor.

• ArcView® has several tools and extensions to assist you in making colorful, attractive
maps.

• Layout GUI allows insertion of any View Frame (views, tables, charts, etc.)
• North arrows, map scale, text, and image files (.jpg, .gif, .bmp) can be inserted into a

layout.
• Templates can be made from a layout to be used in other layouts.
• Save your project before creating a layout.
• Legend properties are dependent on the legend properties of a view.
• Map Units and Distance Units must be set before adding a scale bar.



35

Exercise 7.

1. If you have closed the aztowns.apr project, open it again.

2. Select Layouts under the Project document window

3. Maximize the Layout document.

4. Go the Layout pull-down menu, and select Page Setup.  Set the page layout as necessary.

5. Go the tool bar and click the View Frame button. Click the cross hairs somewhere near the
top left of the windows.  Hold down the left mouse button, and drag to the right and
bottom until the box fills the Layout.  Leave room for the legend, scale bar and north
arrow.  Select View1 from the popup window, then click OK Do not go beyond the blue
lines.  Move or change the size of the view if necessary.

6.  Go to the button bar and select the Legend button  (hold down the mouse button and
scroll down).  Draw a box where you want the legend to appear.  Select View1 from the
pop-up menu.  Place the legend in the lower left of the Layout.  Zoom in on the Legend.
Change the size if necessary.  Notice the legend items.  Close the Layout document and go
back to the View document.  Make the cntybdys.shp shape file active. Go to the Theme
pull-down menu and click on Hide/Show Legend.  Go back to the Layout document and
look at the legend box again.

7. Go to the button bar and select the Scale Bar button .  Select a scale bar style and other
options.  Click OK. While in the layout, adjust the scale bar as necessary.

8. Click on the Text icon .  Add a title at the top of the Layout.  Change the font style and
size by opening the Show Symbol Window  (under the Widow pull-down menu).

9. Close the layout and project.
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What comes next?

• ESRI
- www.esri.com
- 1-800-447-9778
- Listing training programs (local and in Redlands, CA)
- List Serve
- ArcExplorer® download
- ArcUser Magazine

• Certified ESRI ArcView® 3.1 training class through ADOT
- ADOT – TPD course four times a year
- Sponsored by Local Technical Assistance Program (LTAP)

(602) 255-8461 Stefanie DeLeon

• Certified classes through private vendors
- Check with ESRI for names and phone numbers

• Certified classes through Universities and community colleges

• Tutorials and other books
• ESRI’s GIS Store
• SoftStore, Inc.

- 1-888-763-8786
- www.geobooks.com

• Geowarehouse
- 1-800-704-6709
- www.geowarehouse.com

• User groups
- On internet
- Through ADOT-TPD
- Southwest User’s Group (find through ESRI)
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Appendix 1 – Definitions:

Term Definition
Active theme In ArcView, a theme that appears raised in a view’s Table of Contents; many

operations performed in a view work only on active themes.
Address geocoding The process of assigning x,y coordinates to addresses so they can be displayed as

points on a map.
Address matching A process that compares a table of addresses to the address attributes of a theme

to determine whether they are the same.
Alias In ArcView, an additional name for a field in a table.  ArcView displays the alias

instead of the original name.
Application A specific use of GIS; a GIS project.
Area A closed shape (polygon) defined by the line or lines that comprise the boundary;

also, an attribute of a polygon.
Area feature A shape on a map representing a geographic object too large to be depicted as a

point or line.  Examples of area features include counties, census tracts, and
lakes.

ATIS Arizona Transportation Information System.  The term used to describe the
Arizona Department of Transportation’s base road coverage.

Attribute A characteristic of a map feature.  Attributes of a river might include its name,
length, average depth, and so on.  A desktop GIS stores attributes in tables and
links them to the map features that they describe.

Attribute table Information about the features on a map, stored in rows and columns.  Each row
relates to a single feature; each column contains the values for a single
characteristic.

Avenue® The programming language that comes with ArcView. Avenue provides tools for
customizing ArcView and developing applications.

Button bar The middle row of controls in the Document GUI.  A row of buttons.
Chart A graphic representation of tabular data.  A component of an ArcView project

used for representing tabular data graphically.
Class A group or category of attribute values.
Classifying The process of sorting or arranging attribute values into groups or categories; all

members of a group are represented on a map by the same symbol.
Color ramp A range of colors used in a map to show ranking or order among classes.
Coverage An Arc/Info term.  A coverage is a set of thematically associated data considered

as a unit.  It usually represents a single theme or layer such as roads, streams or
land use.

Data A collection of related facts usually arranged in a particular format and gathered
for a particular purpose.

Data dictionary A catalog containing information about the data stored in a GIS database.  A data
dictionary includes such information as the full names of attributes, meanings of
codes, scale of the source data, accuracy of locations, and the map projection
used.

Database A collection of related files organized for efficient retrieval of information.
Datum A set of parameters used to define the 3D shape of the earth.  The basis for a

planar coordinate system.  For example, the North American Datum of 1983
(NAD83) is the datum for map projections used within the United States and
throughout North America.
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Term Definition
Decimal degrees Degrees of latitude and longitude expressed as a decimal rather than in degrees,

minutes, and seconds.  Decimal degrees are computed using this formula:
decimal degrees = degrees + minutes/60 + seconds/3,600.

Desktop GIS A form of desktop mapping that has the ability to display, query, update, and
analyze geographic locations and the information linked to those locations, and
that runs on personal computers.

Desktop mapping A system used for mapping information on personal computers.  Desktop
mapping systems range from display-only systems to full-featured geographic
information systems.

Digital map data The locations and shapes of map features stored in a computer–readable format.
Distance units The units (e.g., feet, miles, meters, or kilometers) ArcView uses to report

measurements, dimensions of shapes, and distance tolerances and offsets.
Document A component of an ArcView project.  Each document type (view, table, chart,

layout, and script) has its own window and interface.

Dynamic
segmentation

The process of computing the locations of events on linear features at run time
based on event tables for which distance measures are available.

Electronic atlas A display-only mapping system that provides pictures (maps) of geographic
areas.

Event location In ArcView, a location stored in a tabular data format rather than a spatial one;
also known as an event.  Examples of event locations are addresses, mileposts
along a route, and latitude-longitude coordinates.

Event table In ArcView, a tabular data source containing location information (event
locations) and used for creating a spatial data theme.

Event theme A spatial data theme created from a table of event locations.
Extension An add-on program that provides specialized GIS functionality to the ArcView

interface.  Extensions are loaded and unloaded in the Extensions dialog box
accessed from the File menu.

Feature A shape and its associated location used to represent a real-world object on a
map.

Field A column in an ArcView table.  Each field contains the values for a single
attribute.

Filtering A desktop GIS operation used to hide (but not delete) features in a map theme.
Geocoding The process of assigning x, y coordinates to data that is not in a spatial data

format, so that the data can be displayed on a map.
Geographic
coordinates

A measurement of a location on the earth’s surface expressed in degrees of
latitude and longitude.  (See also planar coordinate system).

Geographic
Information System
(GIS)

An organized collection of computer hardware, software, and geographic data
designed for capturing, storing, updating, manipulating, analyzing, and
displaying all forms of geographically referenced information.

GIS database A collection of map themes (including features and related descriptive
information) organized for efficient storage and retrieval by many users.

GUI Graphical User Interface. This term is used to refer to the document or window
interface on the computer.

Hot link In ArcView, a way to display data (e.g., a file, image, ArcView document, or
project) directly from a view, by clicking on a feature.

HPMS Highway Performance Monitoring System.
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Term Definition
Image data Graphic representations of objects.  Examples include satellite pictures, aerial

photographs, and scanned documents.  One of the three basic kinds of geographic
data (spatial and tabular data are the other two).

Image file A file containing graphic representations of objects (image data).  Examples of
image file types are JPEG (*.jpg), GIF (*.gif), BitMap (*.bmp).

Join In ArcView, an operation used to attach tabular data to a theme.  The fields of
one table are appended to another table (usually the theme table) using a common
field.  Join establishes a one-to-one or many-ton-one relationship between
records in the two tables.

Layout The design or arrangement of elements in a digital map display or printed map.
A component of an ArcView project used for creating presentation-quality maps.

Legend A list of the symbols appearing on a map; includes a sample of each symbol and
text describing what each symbol means.  (The Map Key).

Legend file In ArcView, a legend created in a View can be saved to a file for use with
another view or project.  Legend files have a .avl extension.

Line A shape defined by at least two pairs of x, y coordinates.
Line feature A shape on a map representing a real-world object too narrow to be depicted as

an area.  Examples of line features include roads, rivers, and elevation contours.
Link In ArcView, an operation used to define a relationship between two tables,

without appending any fields, and using a common field.  Link establishes a one-
to-many relationship between records in the two tables.

Map A graphic representation of an area, using shapes to represent objects and
symbols to describe their nature, organized according to location.

Map display A graphic representation on a computer screen of a geographic area and the
features on it.

Map feature Same as feature
Map projection A mathematical formula that converts latitude-longitude locations on the earth’s

spherical surface to x, y locations on a map’s flat surface.  Map projections cause
distortion in one or more of these spatial properties: distance, area, shape, and
direction.

Map scale Same as scale.
Map units The units (e.g., feet, miles, meters, or kilometers) in which the coordinates of

spatial data are stored.  ArcView uses the current map units to calculate a view’s
scale.

Map symbol Same as symbol.
Neatline A border commonly drawn around geographic features, often to separate them

from other map graphics.
Node The ending points of lines

North arrow A map component that shows how a map is oriented.
Palette A collection of symbols and colors stored in a file that you can load or create.  In

ArcView the palettes (e.g., symbol, line, color, etc) can be accessed from the
Symbol Window, located through the Window menu item.

Planar coordinate
system

A two-dimensional measurement system that locates features on a map based on
their distance from an origin (0,0) along two axes, a horizontal x axis
representing east-west and a vertical y axis representing north-south.  See also
geographic coordinates.

Point A shape defined by a single x, y coordinate.
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Term Definition
Point feature A shape on a map representing a geographic object too small to show as a line or

area.  Examples of point features include wells, hydrants, and benchmarks.
Polygon A shape on a map representing a geographic object too large to be depicted as a

point or line.  Examples of area features include counties, census tracts, and
lakes.

Project In ArcView, a file for organizing your work.  Projects use five types of
documents to organize information: views, tables, charts, layouts, and scripts.

Projection Same as map projection.
Query A question or request used for selecting features or records.  A query often

appears in the form of a statement of logical expression.  In ArcView, a query
contains a field, an operator, and a value.

Record A row in an ArcView table.  If the table is a theme table, each record corresponds
to a single map feature.

Scale The relationship between the dimensions of features one a map and the
geographic objects they represent on the earth, commonly expressed as a fraction
or a ratio.  A map scale of 1/100,000 or 1:100,00 (for example) means that one
unit of measure on the map equals 100,000 of the same unit on the earth; that is,
features on the map are 100,000 times smaller than what they represent in the real
world.

Scale bar A map component that graphically shows a map’s scale. (used in a layout)
Script A component of an ArcView project used for writing, loading, and modifying

programs that contain Avenue code.  ArcView scripts are used for automating
tasks, adding new capabilities to ArcView, and building complete applications.

Select To choose from a number or group of features or records; to create a separate set,
or subset.

Selected set A subset of the features or records in a theme.  ArcView provides several ways to
select features and records graphically or according to their attribute values.

Shape The characteristic appearance or visible form of a geographic object.  Most
geographic objects can be represented on a map using three basic shapes: points,
lines and areas (polygons).  In ArcView, a map feature stored in a shapefile
format.

Shapefile ArcView’s format for storing the location, shape, and attribute information of
geographic features.

Spatial analysis The study of the locations and shapes of geographic features and the relationships
between them.

Spatial data The locations and shapes of geographic features.  One of the three basic kinds of
geographic data (image and tabular data are the others).

Spatial join A type of spatial analysis in which the attributes of features in two different
themes are joined together based on the relative locations of the features.

Spatial overlay The process of superimposing layers (themes) of geographic data that occupy the
same space in order to study the relationships between them.

Spatial relationship A relationship between geographic features based on their locations.  Spatial
relationships are shown on maps.

Street network A system of interconnecting lines that represent thoroughfares.
Street-based
mapping

A form of desktop mapping that links information to geographic locations and
displays address locations as point features on a map.

Symbol A graphic element used in a map to help identify and provide information about a
feature.
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Term Definition
Symbol window In ArcView, the window used to create/maintain/use various symbols, colors,

lines, fonts, and polygons.
Table Information formatted in rows and columns.  A component of an ArcView

project used for displaying tabular data. See attribute table.
Table of Contents
(TOC)

In an ArcView view, this is the portion of the view GUI that lists the themes in
the view.  The Table of Contents is also used to control how the view is drawn.

Tabular data Descriptive information, including locations, that is stored in rows and columns
and can be linked to map features.  One of the three basic kinds of geographic
data (image and spatial data are the others).

Text label Text added to a map to help identify a feature.
Thematic mapping A form of desktop mapping that uses information stored in a spreadsheet or

database to create map displays for graphic presentations.
Theme A set of related geographic features, such as streets, parcels, or rivers, and the

attributes (characteristics) of those features.
Theme table In ArcView, a table of attributes linked to features in a theme. See attribute table.
Theme-on-theme
selection

In ArcView, an operation that selects features in one theme using the features of
another theme.  Answers questions about spatial relationships between features,
such as whether one feature lies within another, whether it completely contains
another, whether it is within a specified distance of another, and so on.

Tool bar The bottom row of icons (referred to as ‘tools’) in the Document GUI (docGUI).
A Tool provides a means of interacting with the document display.  A tool
remains selected until you click on another tool.

Topographic maps A graphic representation of natural and man-made features showing their relative
positions and elevations.

View A component of an ArcView project used for displaying, querying, and analyzing
geographic themes.

Window application Used in the documentation to refer to the ArcView program window running on a
computer.

X axis In a planar coordinate system, the horizontal axis representing east-west.
X, y coordinates On a flat map, a location (its distance, horizontally and vertically, from an origin)

that corresponds to the same location on the earth’s spherical surface.
Y axis In a planar coordinate system, the vertical axis representing north-south.
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Appendix 2 – Cool Web Sites:

Arizona Department of Transportation/Transportation Planning Division
• ArcView Internet Map Server
• GIS data, maps, misc.
• mapazfms.com

Arizona Department of Transportation/Traffic Operations Branch
• Highway Closure Reporting System (HCRS)
• GIS data, maps, misc.
• Freeway cameras
• www.azfms.com

Arizona Land Resource Information System (ALRIS)
• Training, data, news
• www.land.state.az.us/alris/alrishome.html

Dave’s Software Library
• Avenue USGS scripts, macros
• rmmcweb.cr.usgs.gov/~dcatts/software/

Environmental Systems Research Instate (ESRI)
• Training, software, conferences, data, scripts, news, et al
• ArcExplorer® download
• www.esri.com

Gator.net
• Avenue Scripts
• www.gator.net/~garyg/aveSrcFrm.htm

Geoplace
• Training, data, news, jobs, services, conferences, books, et al
• www.geoplace.com

Geowarehouse
• Extension, Scripts, training, et al
• www.geowarehouse.com

Knowledge Base
• www.gfi-gis.de/en/services/avkb
• List Serve Summaries on keywords
• Southwest User’s Group (find through ESRI)

Rowekamp Associates, Inc.
• Misc. sites
• www.rowekamp.com
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University of Texas – Geography Department
• Map projections and datums
• www.utexas.edu/depts/grg/gcraft/notes/mapproj/mapproj.html

United State Geological Survey (USGS)
• Maps, DEMs, data, et al
• www.usgs.gov






